**Unit Title:** Intertextuality: Easy A and the Scarlet Letter  
**Grade Level:** Year 11

**Subject:** Stage 1 English  
**Time Frame:** 3 weeks (2 x singles, 1 x double)

**Performance Standards:**
- KU1: Knowledge and understanding of ideas and perspectives explored in texts.
- KU2: Knowledge and understanding of language and stylistic features and conventions to make meaning.
- An3: Analysis of intertextual connections.
- Ap1: Precision, fluency and coherence of writing and speaking.
- Ap3: Use of evidence from texts to support conclusions, with textual references incorporated in responses.

**Context:** The class consists of 20 students (12 girls, 8 boys). The class is at a moderate academic level with a ‘B’ average. When constructing analytical written pieces, some students struggle to write succinctly and with clarity. The assessment task will be scaffolded with an interview plan pro forma in alignment with assessment requirements. Each student has their own laptop.

**Essential Questions:** What is intertextuality? How do I identify implicit and explicit intertextuality in a text? What is the purpose of intertextuality? How does intertextuality deepen our understanding of the ideas, themes and perspectives in texts? How can I write and speak fluently and precisely about intertextuality?

**Prior Knowledge:** During earlier years of schooling, students have learnt to analyse texts for meaning. During the first part of the semester in Stage 1 English, students have practised analysing texts for ideas and perspectives as well as the conventions, language and stylistic features authors use to make meaning. Students know how to construct analytical English essays. During this unit, students will be introduced to intertextuality for the first time. Earlier tasks in the semester have included the study of poetry through a feminist lens and students have experienced a film study, resulting in a familiarity with analysing film techniques.

**Knowledge Outcomes:** students will know...
- the definition of intertextuality
- the purpose of intertextuality
- the ideas, themes and perspectives in the film Easy A
- how intertextuality deepens our understanding of the ideas, themes and perspectives in texts

**Skill Outcomes:** students will be able to...
- identify intertextuality - implicit and explicit
- analyse the effect of intertextuality
- construct a radio interview
- record and edit using Audacity
- write and speak fluently about intertextuality

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Plan</th>
</tr>
</thead>
</table>
| **L1** 50 min **Week 1** | *Introduction to Intertextuality.*  
Overview of the concept. ClickView activity including references to pop culture. For example song lyrics and videos (Roar - Katy Perry, Love Story - Taylor Swift) and The Simpsons. |
<table>
<thead>
<tr>
<th>L2 + L3</th>
<th>100 min</th>
<th>Watch the film <em>Easy A</em> complemented by scaffolded note taking. Discussion and plenary at the conclusion of the lesson.</th>
</tr>
</thead>
<tbody>
<tr>
<td>L4</td>
<td>50 min</td>
<td>Introduction to <em>The Scarlet Letter</em>. Viewing of <em>Easy A</em> clips which reference <em>The Scarlet Letter</em>. Lesson will include discussion addressing implicit and explicit intertextual references, filmic techniques, internal monologue, themes (virtue, gender constructs, and ostracism), and authorial and historical context.</td>
</tr>
<tr>
<td>L5</td>
<td>50 min</td>
<td>Introduction to <em>The Scarlet Letter</em>. Viewing of <em>Easy A</em> clips which reference <em>The Scarlet Letter</em>. Lesson will include discussion addressing implicit and explicit intertextual references, filmic techniques, internal monologue, themes (virtue, gender constructs, and ostracism), and authorial and historical context.</td>
</tr>
<tr>
<td>L6 + L7</td>
<td>100 min</td>
<td>Introduce ‘How to Podcast with Audacity’ to students. Use a small group activity with place mats to consolidate noted and knowledge. Ensure that students are engaged in considered discussion and scaffolded by questions. <em>This will form a summative assessment for the unit.</em> Once students have discussed each of the topics, students are to present a summary of their discussions to the class. Assessment tasks will be distributed amongst students. Discuss the nature of the text type and go through the scaffolding for the assignment. Allow time for students to brainstorm radio broadcast language features and discuss ideas for their assignment.</td>
</tr>
<tr>
<td>L8</td>
<td>50 min</td>
<td>Students to begin writing their assignment (radio interviews - podcast) by using the scaffold. Students will have the opportunity to have the teacher draft their work over the weekend.</td>
</tr>
<tr>
<td>L9</td>
<td>50 min</td>
<td>Peer editing of assignment. Students will read their interviews to each other, discuss them and justify. Students to then edit and continue writing.</td>
</tr>
<tr>
<td>L10 + L11</td>
<td>100 min</td>
<td>Students will record and edit using Audacity. They will work in pairs to record and individually to edit.</td>
</tr>
<tr>
<td>L12</td>
<td>50 min</td>
<td>This lesson will provide an opportunity for final editing. Students are to submit their radio interview (podcast) on Monday.</td>
</tr>
</tbody>
</table>

**Resources required:**
- students will have laptops for each lesson
- ClickView with *Easy A* available for students to access at home and school
- various clips on ClickView
- Audacity downloaded to laptops (free program)
- *The Scarlet Letter* - copies available in the school library
- 20 x assessment task sheets
- 20 x scaffolded note taking sheets
- 20 x assignment scaffold sheets
Plot Summary

*Easy A* is a romantic comedy film written by Bert V. Royal and directed by Will Gluck. It follows Olive Penderghast as she becomes a victim of the high school ‘rumour mill’ after lying to her best friend about a weekend tryst. The screenplay was inspired partially by the novel *The Scarlet Letter* by Nathaniel Hawthorne and contains many intertextual references.

Core Themes

Virtue: the idea of moral excellence

- The theme of virtue is for those students who wish to extend themselves as it is a more conceptual idea that they may not have worked with in the past.

Gender constructs: the way that masculinity and femininity are portrayed based on societies expectations

- This is easily relatable for all students as they will have found it in many texts and real life. The search for identity within gender constructs is everywhere.

Ostracism: exclusion from social acceptance by majority of opinion.

- This theme is more controversial and giving them the option to look at it more in depth is interesting for those students who wish to extend themselves. If they feel uncomfortable about it they are able to look at the other themes instead.

Why is it a great text to use in class?

- There are many examples of intertextuality – both implicit and explicit.
- The intertextuality references film as well as novels which can make it easier for less widely read students to connect.
- Intertextuality is used to expand themes.
- The setting is relatable as is it predominantly in a high school.
- The themes are easily relatable to the students as they will have encountered them in the past.
STAGE 1 ENGLISH

ASSESSMENT TYPE 3: INTERTEXTUAL STUDY

Purpose
To understand the concept of intertextuality and to recognise how the author uses intertextual references to create meaning.

Description
In the movie *Easy A* intertextuality is used to create meaning. Discuss this statement in a radio interview making reference to two or more themes such as virtue, gender constructs, and ostracism.

Outline of the task
- View *Easy A* directed by Will Gluck.
- Record a radio interview (podcast) with the author of the screenplay, Bert V. Royal, using the program Audacity.
  - Write a script for your radio interview.
  - Include an introduction for your guest and conclude the interview.
- Formulate 4 – 6 questions to ask the author. These must be negotiated with the teacher before moving on to the response.
- Formulate responses to each of these questions which demonstrate your understanding of the ways in which intertextuality is used to create meaning in the film.
- You will have the opportunity to submit one draft.
- Ensure that you have rehearsed your interview prior to recording.
- Record your interview and edit via Audacity. *Pairs*
- Submit the podcast and transcript on Monday, Week 4 by the start of the lesson.

Assessment conditions
Multimodal (podcast) task up to 6 minutes in length. 4 lessons of class time will be allocated to completing the task, as well as homework. Podcast will be submitted via email. Transcript will be submitted via Turnitin. Both must be submitted by the start of the lesson on Monday, Week 4.
<table>
<thead>
<tr>
<th>Knowledge and Understanding</th>
<th>Analysis</th>
<th>Application</th>
</tr>
</thead>
</table>
| A                           | Detailed knowledge and understanding of ideas and perspectives explored in a diverse range of texts.  
Extensive knowledge and understanding of the variety of conventions, language, and stylistic features authors use to make meaning. | Analysis of complex intertextual connections between different texts. | Fluent and precise writing and speaking.  
Detailed and appropriate use of evidence from texts to support conclusions, with textual references integrated into responses. |
| B                           | Knowledge and understanding of ideas and perspectives explored in a range of texts.  
Knowledge and understanding of a range of conventions, language and stylistic features authors use to make meaning. | Analysis of intertextual connections between different texts. | Mostly fluent and precise writing and speaking.  
Accurate use of evidence from texts to support conclusions, with textual references incorporated fluently in responses. |
<table>
<thead>
<tr>
<th>Grade</th>
<th>Description</th>
<th>Writing Fluency and Accuracy</th>
<th>Evidence Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>C</strong></td>
<td>Knowledge and understanding of ideas and some perspectives explored in a range of texts. Knowledge and understanding of some conventions, language and stylistic features authors use to make meaning.</td>
<td>Generally fluent and accurate writing and speaking. Use of evidence from texts to support conclusions, with some textual references incorporated in responses.</td>
<td></td>
</tr>
<tr>
<td><strong>D</strong></td>
<td>Reference to simple ideas explored in texts. Knowledge and understanding of a narrow range of language features and conventions authors use to make meaning.</td>
<td>Some control and fluency of expression. Limited use of evidence from texts to support conclusions with limited textual references to support responses.</td>
<td></td>
</tr>
<tr>
<td><strong>E</strong></td>
<td>Identification of an idea in a text. Recognition of a restricted range of language features used by authors.</td>
<td>Emerging development of control of expression. Emerging use of some language features appropriate to audience and/or purpose.</td>
<td></td>
</tr>
</tbody>
</table>
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*

**Lesson 1: Introduction to Intertextuality**

*(50 minutes)*

**Objectives:**
- Text Analysis: Interview
- Teaching students to recognise intertextuality and the ways in which it brings meaning to a text
- Teaching the nature of social constructs in multiple contexts
- KU1; An3

**Materials needed**

In classroom:
- Smart Board

Per Student:
- Personal laptop

**Part 1 (5 minutes)**

**Starter Activity:**

I will begin the lesson with a definition of Intertextuality on the board:

> Ideas shared across different texts
> where one references or incorporates the other
> to create meaning.

Once students are settled, I will tell them that for the next 3 weeks we will be focusing on Intertextuality, and they will copy this definition as the beginning of their new English task file. I will then explain the definition in plain terms: Intertextuality means that one text references another to help the reader or viewer gain an understanding of the themes and messages being presented.

**Challenge:**
- Students are given 1 minute to come up with examples of intertextuality as individuals. These will then be shared with the group so that a base line of knowledge can be established.

**Part 2 (10 minutes)**
Teacher-led Teaching: (students to take notes)

A brief overview of the assessment to be completed for this unit will be given so that students are aware of the direction in which their learning is headed.

The concept of intertextuality will be expanded upon to include implicit and explicit definitions.

- **Implicit/Implied Intertextuality**: references which are suggested but not directly expressed.
  
  *Aka allusion*: “a passing reference, without explicit identification to a literary or historical person, place, or event, or to another literary work or passage” (Abrams A Glossary of Literary Terms 2012).

- Example of Implicit/Implied Intertextuality: *Gilmore Girls*, “Say Goodnight, Gracie” [https://youtu.be/Pm9SN1N7xA?t=1m50s](https://youtu.be/Pm9SN1N7xA?t=1m50s) (starting at 1:50). References Bette Midler’s song The Wind Beneath My Wings.

- **Explicit Intertextuality**: references which are detailed, obvious, or directly stated.

- Example of Explicit Intertextuality: *Bing Bang Theory*, “The Bakersfield Expedition” [https://www.youtube.com/watch?v=75TtpQrAv4U](https://www.youtube.com/watch?v=75TtpQrAv4U) (starting at 29:00).

I will also ensure that the students understand that Intertextuality relies upon the reader’s/ viewer’s prior knowledge. Intertextuality can be ineffectual if the reader/ viewer is unaware of the text being referenced.

**Part 3** (30 minutes)

**Student Independent Work:**

**Clickview Activity:**

Students will organise themselves into groups of 4 and will be assigned a text to analyse by answering the following questions:

1. What/who is being referenced?
2. Is it implicit/ implied or explicit Intertextuality?
3. What prior knowledge is the author relying on the reader/ viewer having?
4. What is the scenario in which the reference occurs?
5. Who is doing the referencing and why is this significant?
6. What meaning is brought to the text through the use of intertextuality?

**Clickview clips to be watched:**

- Taylor Swift’s *Love Story*
- The Simpsons *Sharry Bobbins*
- *Space Balls*
- *Shrek the Third*
- Katy Perry’s *Eye of the Tiger*
There will then be a class discussion during which each group will present what they have discovered.

**Part 4** (5 minutes)

**Plenary:**

The students will share one thing that they learned in today’s lesson. This gives me the opportunity to gain feedback and ascertain their understanding of the concept of Intertextuality.

**Homework:** Write your own definition of Intertextuality and give examples of where you have seen it occurring in everyday life.

**Part 5** (5 minutes)

**Personal review:**

- Based on student responses during class, I will evaluate the success of the lesson: did students learn what intertextuality is, how to recognise it, and how it can be used to create meaning in a text.
- Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs
- Common problems and identify great successes which occurred in lesson to address next lesson in starter
  - gives students affirmation that I am consistently watching their participation in class
  - students are given verification of their work in class and feedback constantly
- Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*

**Lesson 2/3: Viewing *Easy A***

(100 minutes)

**Objectives:**
- Text Analysis: Interview
- By the end of the lesson, students will have viewed *Easy A* and have noted use of intertextuality in the film to this point.
- Teaching the nature of social constructs in multiple contexts
- KU1; KU2; An3

**Materials needed**

In classroom:
- Smart Board
- Clickview: *Easy A*, OR DVD and player

Per Student:
- Note Scaffolding Sheets.

**Part 1 (2 minutes)**

**Starter:** Overview film techniques in pairs.

This is a very brief introduction to get students to recall previous knowledge and to get them focussed on what is required in the lesson to come.

Ask students to form pairs where they are sitting. Each pair is to list as many film analysis techniques they can recall from previous film study unit in 2 minutes. Take a poll of answers at the end and announce a winner.

**Part 2 (1 minute)**

**Introduction:**

Explain that the class will be watching *Easy A* over the next two lessons. Students are to watch the film and fill out the provided scaffolding sheets to assist them in considering the role of intertextuality in the film. Students will receive one of four sheets that will then be used to collaborate with a group in later lessons.

See appendix for worksheets.
Part 3 (90 minutes)

Student Independent Work/ Development:

Class to view Easy A and take notes using provided sheets.

As the film is 90 minutes long, it is critical that 45 minutes is given to watching it in this lesson.

Part 4 (2 minutes)

Plenary:

Ask for feedback from one student on each of the four topics: implicit and explicit intertextual references, filmic techniques, internal monologue & authorial and historical context, and themes. The student shares one example from the film with the rest of the class.

Homework: consolidate notes from lesson (15 minutes)

Part 5 (5 minutes)

Personal Review:

- What worked well?
- What needs work?
- Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs
- Common problems and identify great successes which occurred in lesson to address next lesson in starter
  - gives students affirmation that I am consistently watching their participation in class
  - students are given verification of their work in class and feedback constantly
- Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
<table>
<thead>
<tr>
<th>Implicit</th>
<th>Explicit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description/how it is used</td>
<td>Description/how it is used</td>
</tr>
<tr>
<td>Todd holds up the boom box (reference to <em>Say Anything</em>)</td>
<td>‘A’ symbol worn by Olive (reference to <em>The Scarlet Letter</em>)</td>
</tr>
<tr>
<td>Further taps into romantic ideals portrayed in film.</td>
<td>Becomes Olive’s uniform and solidifies Olive’s rebellion and status as an outcast.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Quotation (if applicable)</td>
<td>Quotation (if applicable)</td>
</tr>
<tr>
<td></td>
<td>“Perhaps you should embroider a red A on your wardrobe, you abominable tramp”. –Nina.</td>
</tr>
<tr>
<td>Effect on Viewer</td>
<td>Effect on Viewer</td>
</tr>
<tr>
<td>Appeals to those who are familiar with this reference.</td>
<td>Creates amusement.</td>
</tr>
<tr>
<td></td>
<td>Evokes sympathy.</td>
</tr>
</tbody>
</table>
## Film techniques

*Based on* Approaches to Senior English *by Alison-Jane Hunter*

<table>
<thead>
<tr>
<th>Easy A</th>
<th>Quotation/Description</th>
<th>Effect on Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linguistic techniques</td>
<td>“I’m swell, guy-I’ve-never-laid-eyes-on-before. Thanks for asking”. - Olive</td>
<td>Wins over the viewer. Allows more serious topics to be considered without being overwhelming.</td>
</tr>
<tr>
<td>Design techniques</td>
<td>Webcam</td>
<td>Draws attention to the fact that situation is being presented from Olive’s point of view.</td>
</tr>
<tr>
<td>Visual Impact</td>
<td>Used to reflect emotional turmoil for Olive</td>
<td>Causes the viewer to pity Olive.</td>
</tr>
</tbody>
</table>

Your Ideas
### Internal Monologue

<table>
<thead>
<tr>
<th>Description/How it is used</th>
<th>Example</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main character reflecting on events according through lens of her personal experience</td>
<td>“People thought I was a dirty skank? Fine. I’d be the dirtiest skank they’ve ever seen”. –Olive.</td>
<td>Shows that Olive is fighting the majority. Gets audience on side.</td>
</tr>
</tbody>
</table>

### Authorial and Historical Context

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>The Scarlet Letter</em></td>
<td>Issues that were prevalent at this time are addressed eg. adultery</td>
<td>This translates into the film, and influences understanding of the issues that are occurring</td>
</tr>
<tr>
<td>Themes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Virtue</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Gender Constructs</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Ostracism</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example</th>
<th>Quote</th>
<th>Effect on Viewer</th>
<th>Example</th>
<th>Quote</th>
<th>Effect on Viewer</th>
<th>Example</th>
<th>Quote</th>
<th>Effect on Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Being a virgin is presented as the desired state for high school girls.</td>
<td>“There's a higher power that will judge you for your indecency”. –Marianne</td>
<td>Viewer considers if they too think this is an issue. Viewer considers reasons for and against this view.</td>
<td>Olive’s mum verbalises the societal expectation for a boy to want to marry her daughter</td>
<td>“Oh, happy day, Mama! Oh, I thought I was gonna have to spend my dowry on booze and pills to numb the loneliness. A gentleman caller, hurray!” -Olive</td>
<td>Viewer considers if this long-held expectation is still relevant. Viewer considers reasons for and against this view.</td>
<td>Olive pretending to have sex with lots of people leads to her being outcast.</td>
<td>“That's the beauty of being a girl in high-school: people hear you had sex once and BAM - you're a bimbo”. -Olive</td>
<td>Viewer considers the impact of social ostracism from multiple perspectives.</td>
</tr>
</tbody>
</table>
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*

Lesson 4: Film techniques, themes and lenses

**Part A**

(50 minutes)

**Objectives:**

- Text Analysis: Interview
- Learning aspects of Text Analysis through a Film Study
- Teaching how to determine what evidence should be used in an analytical film response through learning about cinematic techniques, themes and lenses
- Teaching about the nature of understanding cinematic techniques in order to fully appreciate film art.
- Teaching about understanding depth of English texts through intertextuality.
- Teaching the nature of social constructs in multiple contexts

**Materials needed**

In classroom:

- Interactive whiteboard/projection facilities
- Scene and supporting themes papers

Per student:

- “A” sheet

**Part 1** (10 minutes)

**Starter: Title analysis**

Students would walk into class and these images would be on the board.

Students would then get into pairs and discuss the title *Easy A* on the poster and film focusing on the following questions:

- What do you think the title means?
• How is the title “Easy A” initially presented to the viewer in the theatrical release poster and film? What effect does this have on the audience?
• Why would these colours be used? Hint: think symbolism of colours
• How does it relate to the characters and their experiences in the film?

I would then ask pairs to share their thoughts.

Then ask students to compare the style and colour use to *The Scarlet Letter* novel cover

What connection can you see between *Easy A* and *The Scarlet Letter* from these images?

By introducing both texts but starting with *Easy A* and using *The Scarlet Letter* as a comparison tool from the start of lesson able to highlight to students the approach they should take to the unit. Start with the film and then look at how other texts, including *The Scarlet Letter* influenced it.

By starting the lesson with an image from the film which in itself is an example of intertextuality sets tone that when analysing intertextuality everything in the film, not just dialogue must be considered. Also the fact that the “A” symbol was chosen indicates that this lesson will be looking at how intertextuality through techniques such as symbolism the film connects to themes. With the use of scarlet red colour audience is triggered to think about sacrifice, strength, passion and draws attention compared to white which is symbolic of purity, innocence and wholesomeness.

**Part 2** (25 minutes)

**Teacher-led Teaching/ Introduction:**
Teacher led discussion surrounding the authorial and historical context of *Easy A* and concentrating particularly on *The Scarlet Letter*.

Emphasis is placed on the similarities and differences of society in *Easy A* and *The Scarlet Letter*.

Also discuss themes in film of virtue, gender constructs (male and female) and ostracism.
Part 3 (10 minutes)

Individual Student Work/Development: Symbolism and intertextuality related to “A” in Easy A

Students are given an “A” Sheet (Appendix 1) which has a table on it which they will need to complete. Students fill in this sheet individually.

Students are given this task as an introduction to intertextuality in Easy A as they were introduced to the concept of intertextuality in the previous lesson. Now students have to identify intertextuality in the film. We have specifically chosen to start with “A” as it is the most obvious example in the film.

Part 4 (5 minutes)

Plenary:

Teacher explains how lesson connects to the assessment task and answers questions.

I would ask the class ‘thumbs up’ who does feel comfortable with the content required in the assessment task and ‘thumbs down’ who does not?

I would then reassure students that we will have 2 weeks to ensure they can identify the elements of intertextuality (both explicit and implicit) accurately in the film, relate them to themes and form an argument prior to starting to writing their radio interviews so they do not need to panic.
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*

Lesson 5: Film techniques, themes and lenses

**Part B**

(50 minutes)

**Objectives:**

- Text Analysis: Interview
- Learning aspects of Text Analysis through a Film Study
- Teaching how to determine what evidence should be used in an analytical film response through learning about cinematic techniques, themes and lenses
- Teaching about the nature of understanding cinematic techniques in order to fully appreciate film art.
- Teaching about understanding depth of English texts through intertextuality.
- Teaching the nature of social constructs in multiple contexts

**Materials needed**

In classroom:

- Interactive whiteboard/projection facilities
- Scene and supporting themes papers

Per student:

- “A” sheet

**Part 1** (5 minutes)

**Starter:**

Class discussion regarding lesson 4 to refresh student knowledge

**Part 2** (25 minutes)

**Group discussion:** Implicit intertextuality task

Students get into 4 groups (one for each theme: virtue, gender constructs (male and female) and ostracism) and analyse the scenes from the film which contain implicit intertextuality. Students use ClickView to watch the scenes from film and if necessary the corresponding films being referenced (Appendix 2). In each corner of the room stations for each theme are set up. On pieces of A3 paper a scene from the film is stated and the corresponding theme (Appendix 3). The groups write how intertextuality is used in the scene to emphasise the theme identified.
The groups then rotate clockwise to each corner of the room to address each theme.

Once students have analysed each theme and have returned to their original theme the groups present their findings to the class thereby enabling all students to have information.

Students are then given a final opportunity as individuals to move around the room to the individual scenes again and add additional information to the scenes or respond to what other students have written.

Teacher then collects the pages and collates information ready for distribution to students the following lesson. Since the notes are from students own work ensures ownership of their learning.

**Part 5 (15 minutes)**

Student independent and group work: Think, pair, share explicit intertextuality task

Students work as individuals to brainstorm a list of texts explicitly referenced in the film, *Easy A*.

Teacher then goes through the list and students add to their list to ensure it is complete. Students then study list created and state when the texts were referenced in the film (think).

Students share their answers with a partner (pair).

Teacher then poses the question to the class “why might these texts be explicitly stated in the film?” Still in their pairs students discuss this question.

2 pairs join together and share their answers (share).

In group of 4 students are allocated a text which *Easy A* refers to: *Ferris Bueller’s Day Off*, *The Breakfast Club*, *Say Anything or Can’t Buy Me Love* and using ClickView watch the specific scenes referred to in film (Appendix 4).

Students are then asked to think about the themes discussed in previous implicit task (virtue, gender constructs (male and female) and ostracism) and how these texts are used to emphasise themes of *Easy A*. Does this text get referenced to implicitly also in the film?

Groups share their findings with the class to ensure all students receive information.

**Part 6 (5 minutes)**

Plenary:

Teacher explains how lesson connects to the assessment task and answers questions.

I would ask the class ‘thumbs up’ who does feel comfortable with the content required in the assessment task and ‘thumbs down’ who does not?
I would then reassure students that we will have 2 weeks to ensure they can identify the elements of intertextuality (both explicit and implicit) accurately in the film, relate them to themes and form an argument prior to starting to writing their radio interviews so they do not need to panic.

**Homework:** 15 minutes
Start to think about which theme you can most easily identify in the film and what particular intertextual references you remember emphasised the theme.

**Part 7 (5 minutes)**

**Personal Review:**
Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs

Common problems and identify great successes which occurred in lesson to address next lesson in starter

- gives students affirmation that I am consistently watching their participation in class
- students are given verification of their work in class and feedback constantly

Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
## Appendix 1 – “A”

<table>
<thead>
<tr>
<th>Evidence -when “A” used/referred to in film</th>
<th>Analysis - What does the reference to the “A” reflect upon the character that brought it up?</th>
<th>Analysis – What impact does the discussion/viewing of the “A” have on other characters in the scene?</th>
<th>Analysis – What impact does this scene have on narrative?</th>
<th>Analysis – What impact does this scene have on the viewer?</th>
<th>Analysis – What theme/s does the scene relate to?</th>
<th>Analysis – What lense/s can the scene relate to?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening title sequence has red “A” in <em>Easy A</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Olive discusses <em>The Scarlet Letter</em> explains why “A” was placed on Hester</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nina suggests Olive wears an “A”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>When Olive stitches red “A” on clothing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Olive shows her</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Appendix 2

**ClickView list of scenes**  
*Nina vs Olive* - [https://www.youtube.com/watch?v=6sBUqG--VFl](https://www.youtube.com/watch?v=6sBUqG--VFl)  
*Olive stitching A’s on her clothing scene* - [https://www.youtube.com/watch?v=RZtMR9PZcml](https://www.youtube.com/watch?v=RZtMR9PZcml)  
*Puritanical religious group discussing Olive and singing Go Down Moses* - [https://www.youtube.com/watch?v=u6Pbh4DuTOM](https://www.youtube.com/watch?v=u6Pbh4DuTOM)  
*Olive explains how she wants her life to be like an 80s movie* - [https://www.youtube.com/watch?v=58VhB4R-4XY](https://www.youtube.com/watch?v=58VhB4R-4XY)  
*Ending scene* - [https://www.youtube.com/watch?v=jtrdOJU2ML4](https://www.youtube.com/watch?v=jtrdOJU2ML4)

### Appendix 3 – Example of scene and supporting theme

<table>
<thead>
<tr>
<th>Scene</th>
<th>Supporting Theme</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pool Scene</td>
<td>“I don’t know what they were so upset about I put an A on my clothes just like they asked”</td>
</tr>
</tbody>
</table>

Theme - Ostracism

### Appendix 4

**ClickView list of scenes**  
*Ferris Bueller* opening monologue - [https://www.youtube.com/watch?v=0KFVlWX7eEY](https://www.youtube.com/watch?v=0KFVlWX7eEY)  
*Ferris Bueller* – “When Cameron was in Egypt’s land, let my Cameron go” - [https://www.youtube.com/watch?v=2MU6UyXdPMs](https://www.youtube.com/watch?v=2MU6UyXdPMs)  
*Breakfast Club* final scene - [https://www.youtube.com/watch?v=daU1TYL2ySs](https://www.youtube.com/watch?v=daU1TYL2ySs)
Say Anything trailer - https://www.youtube.com/watch?v=QeUnT3f7eAA

Can’t Buy Me Love ending - https://www.youtube.com/watch?v=eKeRY3lYqOM
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*

Lesson 6/7: Assessment Task

(100 minutes)

Objectives:

- Text Analysis: Interview
- Understanding assessment task and learning how to podcast.
- Teaching the nature of social constructs in multiple contexts
- KU1; KU2; An3; Ap1; Ap3

Materials needed

In classroom:
- Smart Board

Per Student:
- Personal laptop
- Audacity
- Scaffolded worksheets

Part 1 (10 minutes)

Starter:

As students enter the class the opening sequence for *The Simpsons Treehouse of Horror XXIV* is playing and they are challenged to find as many intertextual references as possible. They will start to write a list and then they will be called on at random to share with the class. Once the class has come up with as many references as possible I will play another version of the clip which points out all 50+ references. This links into the first lesson of the unit and makes a clear transition into discussion of the assessment task.

Treehouse of Horror opening: https://www.youtube.com/watch?v=CtgYY7dhTyE

Opening showing references: https://www.youtube.com/watch?v=58ShZDgkBFE

Part 2 (20 minutes)

Teacher-led Teaching: Understanding Assessment
As a class we will be going through the assessment sheet which was given to them in their work pack. All students are expected to record a radio interview (podcast) with the author of the *Easy A* screenplay, Bert V. Royal using Audacity. They must write a script for the radio interview which introduces the guest, includes 4-6 questions and answers which are negotiated with the teacher, and concludes the interview. It should run for approximately 6 minutes and can be recorded with the help of one other student. During recording they must take the role of the screenwriter, and a friend can ask the questions. Everyone in the class is expected to submit one draft which will be submitted through TurnItIn. Students have four lessons of class time with homework time to complete the assessment. There will be time for any questions that students have about the assignment before we move on.

**Part 3 (20 minutes)**

**Teacher-led Teaching: How-To Podcast**

At this point I will explain to the students how to use Audacity to create their podcast. Students already have a copy of the How-To Podcast handout in their work pack. We will go through this as a class and answer any questions that they might have. While going through the handout I will have an example file on the board so that students can see exactly what is happening in the program. If there are any questions or uncertainties they can clarify as we go, and there will be time for questions at the end. If any student is really struggling I will take them aside during the next activity and we can work through it.

**Part 4 (30 minutes)**

**Student Independent Work: Place Mat Group Activity**

Students will be split up into groups of four or five, ensuring that each group has at least one person who took notes on scaffolded worksheet during film watching. Topics covered are: implicit / explicit intertextuality, film techniques, internal monologue / authorial intent, and themes.

Each group will draw a box in the middle of the page and line out from that creating a section for each student. Each student will fill their section with the most important notes that they took from the film viewing. I will ensure that students are engaged in considered discussion and if they need guidance I can give them some questions to answer.

This will become a formative assessment for the unit. Once each student has completed their section they come together in the small groups and choose the most important point from each section and put it into the centre. We then have a class discussion about the most interesting points in the movie and how we can use them in the assessment piece.

**Part 5 (15 minutes)**
Plenary:

Students will begin brainstorming language that might be used in the radio and interview setting. They will start by brainstorming in small groups and then come together as a group and brainstorm onto the whiteboard. If there is time left students can begin discussing their assignments and thinking about interview questions.

Homework:

Students should begin research and brainstorm questions. They will be expected to have at least two questions ready for teacher approval in the next lesson.

Part 6 (5 minutes)

Personal Review:
Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs

Common problems and identify great successes which occurred in lesson to address next lesson in starter

- gives students affirmation that I am consistently watching their participation in class
- students are given verification of their work in class and feedback constantly

Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
How-To Podcast with Audacity

1. You will need to find a quiet place to record the interview with a partner of your choosing.
2. Choose how you want to record the interview:
   - Mobile phone,
   - Mobile phone with headphones,
   - Laptop with built in microphone,
   - Laptop with external microphone,
   - Video camera borrowed from the library.
3. Once you have recorded the interview you will need to import it onto the laptop. How this occurs will depend on how you have chosen to record the sound. See the teacher if you need any help with this.
4. Import the file into Audacity using File > Import > Audio and selecting the file.
5. Listen to the file using the Play button and decide if it needs any editing.
6. See below for specific editing instructions.
7. Make sure you listen to the interview in its entirety to ensure you are happy with the final product.
8. To export the file use File > Save Project and make sure you put your name and the assignment in the title.
9. Email this file to the teacher.

Remove Unnecessary Audio

1. Select the section which you want to cut by clicking and dragging the mouse.
2. Use Edit > Remove Audio or Labels > Cut.
3. This will remove the unwanted audio.

Noise Reduction

1. Select the very beginning of the track (before you begin talking) by clicking and dragging with the mouse. Choose Effect > Noise Reduction and click Get Noise Profile. This enables Audacity to know what the background noise sounds like.
2. Then select the section of the track that you want to remove background noise from. To select the entire track use the Track Control Panel and use Edit > Select > All.
3. Once the track is selected choose Effect > Noise Reduction and this time click the Reduce button, then click OK.
4. Play through the track to ensure that background noise has been removed and the interview has not been affected.
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*

Lesson 8: Interview Script Writing

(50 minutes)

Objectives:

- Text Analysis: Interview
- Teaching students the pro forma to begin writing their interview script
- Teaching the nature of social constructs in multiple contexts.
- KU1; An3; Ap1; Ap3

Materials needed

In classroom:

Per Student:

- Personal laptop
- Scaffolded worksheets
- Notes from previous lessons

Part 1 (5 minutes)

Starter:

A quick class discussion to re-cap the definition/s of Intertextuality, film techniques used, themes represented, and examples in *Easy A*. This should help to consolidate student’s knowledge from previous lessons so that they can begin the assessment task.

Part 2 (10 minutes)

Teacher-led Teaching:

I will do a review of the assessment task sheet and introduce them to the interview writing scaffold. Students will then be allowed to ask questions for clarification if necessary.

Part 3 (30 minutes)

Student Independent Work:

Students will begin to construct their interview questions, with dot points to demonstrate the answers they will create. These questions and dot points will then be checked by the teacher to offer students the opportunity to achieve their best possible analysis of the film. If this does not occur in class, then students may email their questions to the teacher.

Once the questions have been verified, students will begin writing their answers before moving on to the introduction and conclusion sections of their interview scripts.
**Part 4** (5 minutes)

**Plenary:**

Students will share one of their questions with the class. This will encourage the supportive learning environment, and widen the scope of student’s knowledge and understanding.

**Homework:** Complete the interview script over the weekend so that peer editing can occur next lesson.

**Part 5** (5 minutes)

**Personal Review:**

Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs

Common problems and identify great successes which occurred in lesson to address next lesson in starter

- gives students affirmation that I am consistently watching their participation in class
- students are given verification of their work in class and feedback constantly

Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
**Script Writing Template**

**Topic:**
In the movie *Easy A*, intertextuality is used to create meaning. Discuss this statement in a radio interview making reference to two or more themes such as virtue, gender constructs, lying and repentance.

**Instructions:**
Think of your interview script as an essay, you must have an introduction and conclusion, and each of your interview questions and responses will serve as paragraphs. It is important therefore, that each question and response follow logically as they would in an essay.

Be sure to use formal and specific language when discussing techniques, themes, and intertextuality.

Use this template to plan your interview before fully composing it. The word counts and times given are a guide only – the maximum time accepted in 6 minutes.

<table>
<thead>
<tr>
<th>Introduction: approximately 100 words or 30 seconds spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>You need to introduce:</td>
</tr>
<tr>
<td>• Yourself (include your full name and student ID)</td>
</tr>
<tr>
<td>• the radio program and station</td>
</tr>
<tr>
<td>• the film, <em>Easy A</em> (production company, actors, year released)</td>
</tr>
<tr>
<td>• and greet your guest, screen writer Bert V. Royal</td>
</tr>
<tr>
<td>• what you are going to discuss with your guest – themes of the movie and how intertextuality is used to create meaning</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Question/ Response 1: approximately 150 words or 1 minute spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include:</td>
</tr>
<tr>
<td>• a leading statement to open the interview</td>
</tr>
<tr>
<td>• a theme to focus on</td>
</tr>
<tr>
<td>• a technique that is used</td>
</tr>
<tr>
<td>• how is intertextuality is used</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Question:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response:</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Question/ Response 2: approximately 150 words or 1 minute spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include:</td>
</tr>
<tr>
<td>• a connecting statement to lead into the question</td>
</tr>
<tr>
<td>• a theme to focus on</td>
</tr>
<tr>
<td>• a technique that is used</td>
</tr>
<tr>
<td>• how is intertextuality is used</td>
</tr>
</tbody>
</table>

<p>| Question: |</p>
<table>
<thead>
<tr>
<th>Question/Response 3: approximately 150 words or 1 minute spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include:</td>
</tr>
<tr>
<td>• a connecting statement to lead into the question</td>
</tr>
<tr>
<td>• a theme to focus on</td>
</tr>
<tr>
<td>• a technique that is used</td>
</tr>
<tr>
<td>• how is intertextuality is used</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Question:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response:</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Question/Response 4: approximately 150 words or 1 minute spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question:</td>
</tr>
<tr>
<td>Response:</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Question/Response 5: approximately 150 words or 1 minute spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question:</td>
</tr>
<tr>
<td>Response:</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Question/Response 6: approximately 150 words or 1 minute spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question:</td>
</tr>
<tr>
<td>Response:</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
<tr>
<td>•</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Conclusion: approximately 100 words or 30 seconds spoken</th>
</tr>
</thead>
<tbody>
<tr>
<td>You need to:</td>
</tr>
<tr>
<td>• summarise the themes in the film and state how intertextuality is used to create meaning</td>
</tr>
<tr>
<td>• thank your guest</td>
</tr>
<tr>
<td>• sign off the segment – thank your listeners</td>
</tr>
</tbody>
</table>
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*

**Lesson 9: Peer Editing**

(50 minutes)

**Objectives:**

- Text Analysis: Interview
- Students are to learn how to edit successfully in order to meet assessment requirements and to write with precision, fluency and coherence.
- Teaching the nature of social constructs in multiple contexts.
- KU2; An3; Ap1; Ap3

**Materials needed**

In classroom:

- sticky notes
- whiteboard + whiteboard markers
- extra copies of assessment task and rubric

Per Student:

- Personal laptop
- Scaffolded worksheets
- Notes from previous lessons
- Green, Pink, and Blue sticky notes

**Key Questions:**

What are the themes and ideas in ‘Easy A’? What are some examples of intertextuality in ‘Easy A’ and how do they create meaning? What are the textual features of a radio interview? How do I edit my radio interview transcript in alignment with the assessment requirements? How do I edit my radio interview in order to achieve precision, fluency and coherence when speaking?

**Part 1 (10 minutes)**

**Starter:** Independent work followed by teacher-led introduction

‘Sticky Definitions’. As students enter the classroom, hand them a sticky note and instruct them to address the following:

- Green: a theme in ‘Easy A’ with textual reference
Pink: example of intertextuality in ‘Easy A’ and how it is used to create meaning

Blue: a textual feature of a radio interview.

Students stick to the board. Discuss the responses. Discuss any gaps in understanding.

**Part 2** (20 minutes)

Student Independent Work/ Introduction: Pair and share

Students are to pair up and read their assignments aloud to/with each other. Using the assessment task details, rubric and knowledge of text type, discuss the drafts and suggest improvements to each other. Choose the best example, ensuring that there are reasons to justify this.

Share - each pair will explain which one fits the requirements of the task the most and why. Read out a great sentence or paragraph, if time allows.

**Part 3** (15 minutes)

Student Independent Work/ Development: Editing

Students will have the opportunity to reflect on what was discussed during ‘Sticky Definitions’ and the feedback from their peer, as well as the class discussion and feedback by editing their work.

**Part 4** (5 minutes)

Plenary:

Students offer one change they’ve made during editing time.

Homework: Continue to edit transcripts.

**Part 5** (5 minutes)

Personal Review:

Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs
Common problems and identify great successes which occurred in lesson to address next lesson in starter

- gives students affirmation that I am consistently watching their participation in class
- students are given verification of their work in class and feedback constantly

Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*.

**Lesson 10/11: Recording and Editing**

*(100 minutes)*

**Objectives:**

- Text Analysis: Interview
- Giving students time to complete the assessment task in class with teacher support available
- Teaching the nature of social constructs in multiple contexts

**Materials Needed:**

In classroom:

Per student:

- Personal laptop
- Audacity
- All scaffolds and notes

**Part 1** (5 minutes)

**Starter:**

A quick re-cap of the assessment task and discussion regarding where students should be up to. Students should be ready to begin recording on audacity by lesson 11 (second half of this lesson block).

Students are reminded that they must record their full name and ID at the beginning of the interview (for SACE purposes).

Students may ask questions for clarification if necessary.

**Part 2** (30 minutes)

**Student Independent Work:**

Students have to opportunity to continue writing and editing their interview scripts OR if rough drafts have been completed then students may form pairs to practise reciting their scripts in preparation for recording.

**Part 3** (10 minutes)

**Teacher-led Teaching:**
To give students a refresher in how to record their interview, I will again show them how to use Audacity effectively.

**Part 4 (50 minutes)**

**Student Independent Work:**

Those students who have not yet formed pairs and practiced reciting their interview will do so now. Students who have had reciting practice will begin recording.

It is anticipated that students will make mistakes, dislike the sound of their own voices, and want to make changes to their recording.

**Part 5 (5 minutes)**

**Plenary:**

Students are to tell the class one interesting thing about their partner’s interview. This should help to encourage a supportive learning environment and give each student confidence in their assessment task.

**Part 6 (5 minutes)**

**Personal Review:**

Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs.

Common problems and identify great successes which occurred in lesson to address next lesson in starter:

- gives students affirmation that I am consistently watching their participation in class
- students are given verification of their work in class and feedback constantly

Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
Unit: Intertextuality: *Easy A* and *The Scarlet Letter*.

**Lesson 12: Final Recording and Editing**

(50 minutes)

**Objectives:**

- Text Analysis: Interview
- Giving students time to complete the assessment task in class with teacher support available
- Teaching the nature of social constructs in multiple contexts

**Materials Needed:**

In classroom:

- Sticky notes

Per student:

- Personal laptop
- Audacity
- All scaffolds and notes

**Part 1 (5 minutes)**

**Starter:**

A quick re-cap of the assessment task and discussion regarding where students should be up to.

Students should be recording on Audacity and making final edits where necessary.

Students will be reminded that their interview scripts are being submitted as part of the assessment task.

Students may ask questions for clarification if necessary.

**Part 2 (40 minutes)**

**Student Independent Work:**

This is the final lesson of class time to complete the assessment task. Students are expected to work constructively. Those who have finished may submit their interview recording and script, and help others in the class who are struggling.

**Part 3 (5 minutes)**

**Plenary:**
Sticky note task - Have students give feedback on the assessment task. What was your favourite aspect of the task? List three things that you learned by completing the task. How would you like to see the task adjusted for future students? Students stick responses to the door on their way out.

Homework: Complete the assessment task, to be submitted before Monday’s lesson begins (week 4).

Part 4 (5 minutes)

Personal Review:
Write notes to self about anything ‘out of the ordinary’ that occurred with a student and track to see if a pattern occurs.

Common problems and identify great successes which occurred in lesson to address next lesson in starter

- gives students affirmation that I am consistently watching their participation in class
- students are given verification of their work in class and feedback constantly

Note down changes to pace of delivery of course and/or degree of content discussed after the past lesson.
Sample Summative Assessment Transcript

Awarded a B

Molly: Welcome back to Late Nights with Molly and George on Radio 99.9. I’m Molly Porch, student number 210012. Tonight’s theme, of course, is flicks that stick. We are looking at movies that have a particularly significant impact on us. Now, George, as you know, I am a huge fan of Emma Stone…

George: I do know this, yes.

M: … which is why I am very excited about tonight’s guest. One of my favourite Emma Stone movies is Easy A. Emma starred in Easy A back in 2010, and this film became an instant hit. It was released by Screen Gems and Olive Bridge Entertainment, and also starred Penn Badgley and Amanda Bynes. It even got four stars on Rotten Tomatoes!

G: Tonight, we are very privileged to have the author of the screenplay of Easy A in the studio with us. Mr Bert V. Royal, welcome to the show.

Bert V. Royal: Thanks so much for having me.

M: Now, Bert, we are both huge fans of Easy A – congratulations on its success!

BVR: That’s very kind, thank you.

M: Now, I assume that when you write a screenplay, there are key messages that you wish to get through to your audience. Can you tell us what key messages you had in your head when writing this screenplay?

BVG: Well, there were several themes that I wanted to explore. One of the major themes that I wanted the audience to grapple with was gender constructs. And you see that throughout the film. Olive has this desire to be swept off her feet by a guy from an ‘80s movie, and yet this doesn’t reflect reality for her. Olive’s experience of attention from the boys at her school could not contrast more. The only male attention from her peers that is positive is from her gay friend Brandon. I wanted the audience to explore how gender constructs have developed and changed. Why does Olive feel this need to be swept off her feet just like the girls in these movies? Is this a realistic expectation for her? Should she be waiting for her dream man to make a dramatic gesture to convince her of his love?

G: I’m glad you brought up the ‘80s references. We see so many of them in this film: Ferris Bueller, The Breakfast Club, Sixteen Candles... to name a few. What is the significance of these references in the film?

BVG: Will Gluck, the wonderful director of this film, explains it this way: he says that in everyday life, “we always talk in movies references, so why can’t the characters in movies talk in movie
It helps to show that the character isn’t the first person in the world to go through this scenario, but that someone else has experienced it before. This connects to the viewer, as they feel this same sentiment as they watch the film. The more connected to the character that the audience feels, the more the audience empathises with the journey that they go on.

M: That is so true. As I watched *Easy A*, I felt myself connecting to the main character, Olive. I wanted to experience romance in the way that she described. The interesting thing is, though, that the movies she references were all released before I was even born. Do you think that matters?

BVG: In *Easy A*, Gluck stated that the ‘80s movies he referenced were accompanied by clips of the films. This meant that viewers who hadn’t necessarily seen the ‘80s movies could still understand them, and so they weren’t alienated.

M: That’s very interesting. And there are many other references in the movie that people are probably even less familiar with. What significance do the explicit references to *The Scarlet Letter* have in *Easy A*?

BVG: The official term for this referencing is intertextuality. It is understood to be a ‘re-authoring’ of the thing that it is referring to. This relates back to our discussion about the references to ‘80s movies. It is this idea that nothing is original; it has all been imagined, discussed, published before. By reinventing it, we are able to understand it anew. The frames through which we see these intertextual references shape how we understand them.

G: Can you give us an example of this in the film?

BVG: The ‘A’ that Olive wears is a classic example. This is one of the ways that another key theme is explored – ostracism. Part of the meaning of this reference comes from understanding the original context, and this is the frame through which we see and understand her wearing the ‘A’. In the film, this understanding is spelt out for us. Olive explains that the ‘A’ she attaches to her corset is as her peers requested - in direct reference to *The Scarlet Letter*. As she is studying this text in her English class, she is able to give the background required to understand this reference properly. The letter is a symbol and a sign, stating to the school that she is a slut. For Olive, it communicates that she is standing up to society, fighting back and trying to prove that she doesn’t care. In its original context, the letter states that the wearer is an adulterer. This is not the direct meaning in *Easy A*. The important thing is that this meaning is repurposed in its new setting. To the viewer, it communicates shame, being ostracized, being judged by others for what society deems ‘wrong’. This is a powerful message that gives weight, then, to what Olive experiences. It becomes less of a teen drama that plays out between a few seventeen-year-old-girls, and more of a statement about the division between right and wrong. It is an ongoing issue that becomes anchored in the past. The significance of the statement is multiplied through the explicit intertextuality.

---


M: Well, Bert, you have given us a true insight into some of the key themes of the movie, those of gender constructs and ostracism. We have particularly enjoyed understanding how intertextuality has given meaning to these themes. Thanks so much for joining us tonight.

BVR: Thanks very much for having me.

G: That’s all we have time for tonight. This has been Late Nights with Molly and George. Thanks for listening. Catch you all tomorrow night.

M: Bye, guys!